Note

CHAPTER

Installing CiscoWorks Common Services 3.0.5

This chapter describes the tasks you have to perform for installing, upgrading, and uninstalling
CiscoWorks Common Services 3.0.5 on a Windows system.

Common Services 3.0.5 is an incremental patch that is bundled alongwith the LMS 2.6 Update CD.

You must install Common Services 3.0.3 before installing Common Services 3.0.5.

The installation process is explained in detail in the following sections:

Installation Overview, page 2-2

Preparing to Install CiscoWorks Common Services 3.0.5, page 2-3
Prerequisites for Installing Common Services 3.0.5, page 2-6
Installation Modes, page 2-7

Performing Upgrade Installation, page 2-17

Upgrade Installation for Common Services 3.0.5, page 2-21
Reinstalling Common Services 3.0.5, page 2-32

Verifying CS 3.0.5 Installation, page 2-34

Checking for Installation Errors for Common Services 3.0.5, page 2-34

Uninstalling CiscoWorks Common Services 3.0.5, page 2-35
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M Installation Overview

Installation Overview

This section provides an overview of the CiscoWorks CiscoWorks Common Services installation tasks.
Table 2-1 contains references to more detailed information about each task.

N

Note  You can install CS 3.0.5 only after installing CS 3.0.3.

Table 2-1 Installing CiscoWorks Common Services Task Overview

Task Steps References

Prepare to install | 1. Verify server “Prerequisites” chapter, “Server Requirements” section on page 1-3
CiscoWorks requirements are met

Common 2. Install required Microsoft |“Installing Required Microsoft Software” section on page 2-4

Services. software on the server if it

is not already installed

3. Verify client requirements |“Prerequisites” chapter, “Client Requirements” section on page 1-7
are met

4. Verify TCP ports that “TCP and UDP Ports Information” section on page 2-5
CiscoWorks uses and
check for conflicts with
existing applications.

To find whether a TCP
port is in use, enter:

netstat -a -n -p tcp |
grep port number

If the port is in use, a
message appears that it is
in the LISTEN state.

grep command will not
work, if you have not
installed the mks tool kit.
In that case, enter:

netstat -a -n -p tcp >
abc.txt

notepad abc.txt

The list of ports opens in a
Notepad.

Install Common |Run the installation program |“Prerequisites for Installing Common Services 3.0.5” section on
Services. page 2-6

“For troubleshooting information, see Appendix A, “Troubleshooting
the Installation.”” section on page 2-16

“Reinstalling Common Services 3.0.5” section on page 2-32

Installation and Setup Guide for CiscoWorks Common Services 3.0.5 (Includes CiscoView 6.1.5) on Windows
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Table 2-1 Installing CiscoWorks Common Services Task Overview (continued)
Task Steps References
Verify and 1. Verify that all correct “Verifying CS 3.0.5 Installation” section on page 2-34
troubleshoot services are installed
installation. . - « . . P A . .
2. Analyze installation error |“Troubleshooting the Installation” appendix, “Understanding
messages Installation Error Messages” section on page A-3

Preparing to Install CiscoWorks Common Services 3.0.5

This section details the important notes and preparations before you start installing Common Services.
This sections contains:

¢ Installation Notes, page 2-3

e Installing Required Microsoft Software, page 2-4

e TCP and UDP Ports Information, page 2-5

Installation Notes

e Before you install CiscoWorks Common Services, make sure your server and client environments
meet the hardware and software requirements described in Chapter 1, “Prerequisites.”

e We recommend you:
— Close all applications before running Common Services installation.

— Run the installation from a local CD or a local hard drive to avoid errors due to slow network
performance.

— Install Common Services on a system that has a static IP address.

— Ensure that Windows Management Instrumentation (WMI) services are not running. If they are
running they may lock some CiscoWorks processes and may terminate the installation.

— Ensure that the IIS services are disabled. If IIS services are enabled, the application cannot be
installed.

e We recommend that you do not:

— Install Common Services on a system that is configured as a primary or backup domain
controller.

— Install Common Services on a FAT file system.
— Install Common Services on Windows XP.
— Run any other program when installation is in progress.

— Install Common Services on Advanced Server with terminal services enabled in application
server mode.

— Install Common Services on a system with Internet Information Services (IIS) enabled.

— Install Common Services on a system that does not have name lookup.

Installation and Setup Guide for CiscoWorks Common Services 3.0.5 (Includes CiscoView 6.1.5) on Windows
[ oL-11275-01 .m



Chapter2 Installing CiscoWorks Common Services 3.0.5

M Preparing to Install CiscoWorks Common Services 3.0.5

Do not install Common Services and CiscoSecure Access Control Server (ACS) on the same
machine. This is because ACS mandates CiscoWorks to be configured as an AAA client in it for
CiscoWorks to avail AAA service.

At the same time, you cannot configure ACS as an AAA client as required when ACS and
CiscoWorks co-exist. Hence the configuration required for ACS integration will fail.

Disable the virus scan software on your system. You can restart it after installation is complete.

Disinfect your system and end any Internet Explorer processes that are not responding. If you run
the Common Services installer or uninstaller on a system that is infected with a virus or has an
Internet Explorer process that has stopped responding, the installation or uninstallation process
might stop unexpectedly.

If you are running HP OpenView Network Node Manager or NetView, the installation might take
significantly longer to complete. Stop all
HP OpenView Network Node Manager or NetView services before installing Common Services.

If your system does not have enough disk space, you will see an error message that the installation
system is running out of disk space. You can choose to abort the installation and free up some disk
space on the system and restart the installation, or click Cancel to exit the installation.

Do not select an encrypted directory. Common Services does not support directory encryption.

Do not install from a Network Drive as this will take a longer time to install CiscoWorks
applications.

Installing Required Microsoft Software

Installing Common Services requires three or more Microsoft software applications. This depends on
your system. The major steps required for installing Common Services are:

Step1  Make sure the system has Microsoft Windows 2003 service pack 1 or Advanced server with service pack
3 or 4 installed. To verify the existing service pack:

From the Start menu, select Run and enter winver.

If version 5.0 Service Pack 3 Or version 5.0 Service Pack 4 appears in the Version field,
Service Pack 3 or 4 is already installed.

If this information does not appear, Windows 2000 Service Pack 3 or 4 or Windows 2003 service
pack 1 is not installed. Install it now.

Step2  Make sure Microsoft Internet Explorer 6.0 is installed in the client and is running JVM version
5.0.0.3802 and later.

To verify the JVM version:

a
b.

C.

From the browser, select View > Java Console.
Enable Java Console if it is not listed in View. Select Tools > Internet Options > Advanced.
In the Microsoft VM section, select Java Console Enabled.

Restart Internet Explorer.

[ 'nstallation and Setup Guide for CiscoWorks Common Services 3.0.5 (Includes CiscoView 6.1.5) on Windows
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Step3  Make sure ODBC zDriver Manager 3.5.10 or later (in 3.5x) is installed.

To verify the version of ODBC Driver Manager:

From the Windows desktop, select Start > Settings > Control Panel > Administrative Tools >

Data Sources (ODBC).
Select the About tab.

If necessary, install Microsoft Data Access Component (MDAC) 2.5 or later.

Step4  Make sure that all ODBC Core Components have the same version number. See the Microsoft web site
for installation instructions.

While installing the required server software:

Always retain the newer file when you are prompted by an installation program to replace a newer

file with an older file.

Always reboot your system when you are prompted to do so by an installation program.

You might be asked to register with Microsoft before downloading some of the required software.
Complete the registration. Selections you make during registration will not affect the installation.

TCP and UDP Ports Information

Table 2-2 lists the TCP and UDP ports used by CiscoWorks Common Services.

Table 2-2 TCP and UDP ports used by CiscoWorks Common Services

Port Number |Protocol |Service Name Traffic Direction

514 UDP Syslog Incoming

1741 TCP CiscoWorks HTTP Incoming

43441 TCP Database Incoming

443 TCP CiscoWorks HTTP server in SSL mode |Incoming

9007 TCP Tomcat shutdown Incoming

9009 TCP Ajp13 connector used by Tomcat Incoming

40050 to TCP Ports used by DCR and OGS Incoming

40070

40401 TCP License Server Incoming

22 TCP Secure Shell (SSH) Outgoing

23 TCP Telnet Outgoing

80 TCP Hyper Text Transfer Protocol (HTTP) |Outgoing

161 UDP Standard port for SNMP polling Outgoing

162 UDP Standard port for SNMP traps Outgoing

42340 TCP CiscoWorks Daemon Manager Incoming and Outgoing

42342 UDP Osagent Incoming and Outgoing

69 UDP Trivial File Transfer Protocol (TFTP) |Incoming and Outgoing
Installation and Setup Guide for CiscoWorks Common Services 3.0.5 (Includes CiscoView 6.1.5) on Windows
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Table 2-2 TCP and UDP ports used by CiscoWorks Common Services (continued)

Port Number |Protocol [Service Name Traffic Direction

1683 TCP Internet Inter-ORB Protocol (IIOP) Incoming and Outgoing
port for CiscoWorks gatekeeper

1684 TCP IIOP port for CiscoWorks gatekeeper |Incoming and Outgoing

8088 TCP HIPO port for CiscoWorks gatekeeper |Incoming and Outgoing

514 TCP Remote Copy Protocol Incoming and Outgoing

42350 UDP Event Services Software Service Incoming and Outgoing

(default),

44350

(alternate)

42351 TCP Event Services Software Listening Incoming and Outgoing

(default),

44351

(alternate)

42352 TCP Event Services Software HTTP Incoming and Outgoing

(default),

44352

(alternate)

42353 TCP Event Services Software Routing Incoming and Outgoing

(default),

44353

(alternate)

Prerequisites for Installing Common Services 3.0.5

You need to perform a series of procedures to install Common Services 3.0.5. Before installing Common
Services 3.0.5, you must first ensure that CS 3.0.3 is installed. To do this:

Step 1 Install CS 3.0.3

For a fresh installation, you must proceed by first installing CS 3.0.3.

Note = Make sure you upgrade all applications to LMS 2.5.1 level and then only proceed to install from the LMS
2.6 Update CD ROM.

Step2  Install CS 3.0.5

After installing CS 3.0.3, you must proceed with installing CS 3.0.5.
Step3  Verify the installation

After installing CS 3.0.5, you must verify the installation.

For verifying installation, see Verifying CS 3.0.5 Installation, page 2-34

Installation and Setup Guide for CiscoWorks Common Services 3.0.5 (Includes CiscoView 6.1.5) on Windows
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Installation Modes

~

Note

You can install CS 3.0.5 either using either the Typical or the Custom mode:

e Select Typical to select the components and install the selected components in the default location
(System Drive\Program Files\CSCOpx). This is the default installation mode.
(See the New Installation—Typical section.)

¢ Select Custom to select optional components, customize the settings, and to specify the location.
(See the New Installation—Custom section.)

The CiscoWorks Common Services installation program takes approximately 45 minutes to complete on
a Windows system with the minimum required hardware. This can extend to one hour if you perform
network management integration while installing.

If Virus Check is enabled in your system then installation of CiscoWorks applications will take longer
time.

For information on setting up multi-homed systems, see the Release Notes for CiscoWorks Common
Services 3.0.5 (Includes CiscoView 6.1.5) on Windows and Release Notes for CiscoWorks Common
Services 3.0.3 (Includes CiscoView 6.1.2) on Windows.

New Installation—Typical

Step 1

Step 2

Step 3

Step 4

Step 5

To install CS 3.0.5, you must first install CS 3.0.3 using the Typical mode, from the LMS 2.5.1 CD
(install CS 3.0.3 from the CD One 3.0.3 CD ROM), and then proceed with installing CS 3.0.5 from the
LMS 2.6 Update CD-ROM.

To proceed with the installation:

Install the required software as described in the “Server Requirements” section on page 1-3.

If you are running Windows 2000, make sure Windows 2000 Service Pack 3 or Service Pack 4 is
installed. If you have Service Pack 1 and or Service Pack 2, the installation exits.

Insert the CS 3.0.3 CD-ROM into the CD-ROM drive.

The Installer screen appears.

Click Install to continue.

The Welcome screen appears.

Click Next to continue.

The Software License Agreement dialog box appears.

Click Accept to accept the license agreement and proceed with the installation.
To deny the agreement and stop the installation, click Do Not Accept.

e If you select Accept, and continue with the installation, the installation program checks the name
lookup and Dynamic Host Configuration Protocol (DHCP).

e [If static IP address is not configured on your system, the DHCP—Enabled Network Adapters dialog
box appears. Click Yes to continue installation.

The Setup Type dialog box appears.
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Step 6

Step 7

Step 8

Step 9

Step 10

Step 11

Step 12

Click Next to continue after you select the desired installation mode as Typical (see Installation Modes,
page 2-7).

The Select Components dialog box appears.
Select the components you want to install:

If Common Services has been installed previously on this system, the list of components will be
different.

¢ Select Common Services 3.0.3 (CS) to install Common Services 3.0.3.
e Select CiscoView 6.1.2 to install both CiscoView and Common Services.
e Select Integration Utility 1.6 to install Integration Utility.

(For information about the Integration Utility and third-party NMS integration, see User Guide for
CiscoWorks Integration Utility 1.6.)

e Click Select All to select all of the above components.
Click Next to continue.
The installation program checks dependencies and component requirements.

The System Requirements dialog box appears with the system requirements, available space in the drive
and Temp Directory (% TEMP%), and available memory.

e If your system does not meet the requirements, a warning appears:

System memory is less than the minimum requirement, which may affect performance.
e If the drive does not have enough space, an error message appears:

There is not enough space in drive drive name.

Please free some space on drive drive name.
e If your system does not have the minimum CPU speed, a warning appears:

Warning: Current CPU speed is less than the minimum requirement, which may affect
performance.

e If your system does not have the minimum swap space, a warning appears:

Warning: Current swap space is less than the minimum requirement, which may affect
performance.

Click Next to continue installation.

The Change Admin Password dialog box appears.

Enter the user admin password and confirm it.

For more information on passwords, see Appendix B, “Password Information.”
Click Next to continue installation.

The Change System Identity Account Password dialog box appears.

Enter the System Identity Account password and confirm it.

In a multi-server environment, you must configure all systems part of your multi-server setup with the
same System Identity Account password.

For more information on passwords, see Appendix B, “Password Information.”
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Step13  Click Next to continue installation.

If you are installing Common Services 3.0.3 on a system for the first time, the Create casuser dialog box
appears after you enter the System Identity Account password.

e Click No to exit the installation and create casuser yourself and rerun the installation. Casuser is the
user who administers and maintains CiscoWorks Server, without having administrative privileges.

e Click Yes to allow the installation program to create the local user casuser.

If you select Yes and continue with the installation, the Summary dialog box appears, displaying the
summary of settings for the installation.

e If you want to view passwords and other security sensitive data, click Show Details. The Show
Details button is visible only if Common Services has been installed as one of the options.

If you click Show Details, the Security Alert dialog box appears.

— Click Yes in the Security Alert dialog box to view the Summary page with the passwords and
other security sensitive data.

You can select and copy the data from the Summary page.
- Click Hide Details to hide the details.
If you want to change any settings, click Back.
Step14 Click Next to continue.
The installation proceeds.

If you are installing from a network drive, the installation might take longer to complete. This happens
especially for CiscoView device packages.

The Restart dialog box appears after installation completes.
Step15 Select Yes and click Finish.

A

Caution  You must reboot the system after installing Common Services 3.0.3 and then proceed to install Common
Services 3.0.5. The installation of other CiscoWorks products may fail if you do not restart.

Your Windows machine has CS 3.0.3 installed successfully.

Now, from the LMS 2.6 Update CD ROM you need to install CS 3.0.5.

To install CS 3.0.5 from LMS 2.6 Update CD:
Step16 Log in as the local administrator on the system on which you installed Common Services 3.0.3.
Step17 Insert the LMS 2.6 CD-ROM into a CD-ROM drive.

The Installer window appears.

If the Installer window does not appear:

a. Select Start > Run.

The Run dialog box opens.

b. In the Open field, enter drive:\autorun.exe

where drive is the CD-ROM drive letter.
Step18 While installing from the network drive, the Installing from Network Drive window appears.

Installation from network drive will be slower when compared to installing from the local drive.

Click Yes to proceed or No to exit installation.
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Step 19

Step 20

Step 21

Step 22

Step 23

Note

Step 24

Step 25

Step 26

If the WMI service is up and running, the following message appears when installation starts.

The setup program has detected Windows Management Instrumentation (WMI) services running.

This will lock some cisco works processes and may abort installation abruptly.
To avoid this, installation will stop and start the WMI services.

Do you want to proceed?

Click Yes to proceed with this installation.
Click No to exit installation.
The IIS detection window appears.
IIS should be in disabled state. If not, to disable IIS in your machine, follow the instructions as below:
¢ Select Start < Run < services.msc < IIS Admin Service.
e Right click on IIS Admin Service and click Stop.
e IS is now disabled. You need to go back to your installation screen to resume installation.
Click OK to continue.
The Welcome window appears.
Click Next to continue.
The Software License Agreement window appears.
Click Accept to accept the license agreement and proceed with the installation.

The Install Updates screen appears displaying the new updates that needs to be installed as well as the
updates that are already installed.

The new updates list will display all applications you previously installed during CS 3.0.3 installation
that now require to be updated to the LMS 2.6 level. CiscoView 6.1.5 is also listed here.

Click either Next to proceed with the installation or Cancel to exit from the installation.
The System Requirements screen appears:

Click Next.

The Summary window appears.

Click Next.

The Setup screen appears, displaying installation progress while files are copied and applications are
configured.

If you have not installed all the LMS 2.5.1 applications before installng the LMS 2.6 Update, the
installation aborts with the following error message (for example, if Resource Manager Essentials 4.0.3
application was not installed):

Install Resource Manager Essentials 4.0.3 before updating to Resource Manager Essentials
4.0.5.

See the ReadMe and the Installation Guide for details.
The following message appears:

If you plan to install any of the LMS 2.5.1 applications, you must reinstall CiscoWorks
LMS 2.6 Update after installing these applications.

[ 'nstallation and Setup Guide for CiscoWorks Common Services 3.0.5 (Includes CiscoView 6.1.5) on Windows
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Step 27

Step 28

Installation Modes

Click OK.
The Setup Complete dialog box appears.
Click Finish.

You have completed the CS 3.0.5 installation from the LMS 2.6 Update CD ROM and your Windows
machine has CS 3.0.5 installed successfully.

See “Checking for Installation Errors for Common Services 3.0.5” section on page 2-34 for details on
installation errors.

To prepare the client system for use, see Chapter 3, “Preparing to Use CiscoWorks Common Services.”

For troubleshooting information, see Appendix A, “Troubleshooting the Installation.”

New Installation—Custom

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

To install CS 3.0.5, you must first install CS 3.0.3 using the Custom mode, from the LMS 2.5.1 CD
(install CS 3.0.3 from the CD One 3.0.3 CD ROM), and then proceed with installing CS 3.0.5 from the
LMS 2.6 Update CD-ROM:

To proceed with the installation:

Install the required software as described in the “Server Requirements” section on page 1-3.

If you are running Windows 2000, make sure Windows 2000 Service Pack 3 or Service Pack 4 is
installed. If you have Service Pack 1 and or Service Pack 2, the installation exits.

Insert the CS 3.0.3 CD-ROM into the CD-ROM drive.

The Installer screen appears.

Click Install to continue.

The Welcome screen appears.

Click Next to continue.

The Software License Agreement dialog box appears.

Click Accept to accept the license agreement and proceed with the installation.
To deny the agreement and stop the installation, click Do Not Accept.

e If you select Accept, and continue with the installation, the installation program checks the name
lookup and Dynamic Host Configuration Protocol (DHCP).

e If static IP address is not configured on your system, the DHCP-Enabled Network Adapters dialog
box appears. Click Yes to continue installation.

The Setup Type dialog box appears.

Click Next to continue after you select the desired installation mode as Custom (see Installation Modes,
page 2-7).

The Choose Destination Folder dialog box appears with the default location (System Drive\Program
Files\CSCOpx).

To install in another location, click Browse and select the location.

We recommend that you specify a short pathname, for example like System Drive:\program
files\CSCOpx, for the destination folder.
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If the folder CSCOpx already exists in System Drive:\Program Files with files or folders, a message
appears:

The selected folder, System Drive\program files\CSCOpx is not empty. Mixing new and
existing files can cause severe problems during installation. Please remove all files
from this folder or choose another folder to install the product.

You must remove all files from this folder or choose another location to install Common Services.
Step7  Click Next to accept the default location.
Or
a. Select another location and click OK,
b. Click Next.
Do not select an encrypted directory. CiscoWorks does not support directory encryption.
The Select Components dialog box appears.
Step8  Select the components you want to install. You can:
¢ Select Common Services 3.0.3 (CS) to install Common Services 3.0.3.
¢ Select CiscoView 6.1.2 to install both CiscoView and Common Services.
e Select Integration Utility 1.6 to install Integration Utility.

(For information about the Integration Utility and third-party NMS integration, see User Guide for
CiscoWorks Integration Utility 1.6.)

¢ Click Select All to select all of the above components
Step9  Click Next to continue.
The installation program checks dependencies and component requirements.

The System Requirements dialog box appears. It displays the component requirements, available space
in the drive and Temp Directory(% TEMP%), and available memory in megabytes.

e If your system does not meet the requirements, a warning appears:
System memory is less than the minimum requirement, which may affect performance.
e If the drive does not have enough space, an error message appears:

There is not enough space in drive drive name.

Please free some space on drive drive name.
e If your system does not have the minimum CPU speed, a warning appears:

Warning: Current CPU speed is less than the minimum requirement, which may affect
performance.

e If your system does not have the minimum swap space, a warning appears:

Warning: Current swap space is less than the minimum requirement, which may affect
performance.

Step10 Click Next to continue.

The Change Admin and Guest Password dialog box appears.
Step11  Enter user admin and user guest passwords and confirm them.

For more information on passwords, see Appendix B, “Password Information.”
Step12 Click Next to continue installation.

The Change System Identity Account password dialog box appears.

Step13  Enter the System Identity Account password and confirm it.

Installation and Setup Guide for CiscoWorks Common Services 3.0.5 (Includes CiscoView 6.1.5) on Windows
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Step 14

Step 15

Step 16

Step 17
Step 18

Step 19

Note

Step 20

Step 21

Step 22

Step 23

Step 24

Installation Modes

In a multi-server environment, you must configure all systems part of your multi-server setup with the
same System Identity Account password.

For more information on passwords, see Appendix B, “Password Information.”
Click Next.
The Change casuser Password dialog box appears.

Casuser is the user who administers and maintains CiscoWorks Server, without having administrative
privileges.

Enter the casuser password and confirm it.

If you do not enter a password, the installation program generates a random password and adds the new
user casuser and the new group casusers to the system.

Click Next to continue installation.

The Common Services Database Password dialog box appears.

Enter the CiscoWorks Common Services Database password and confirm it.

Click Next to continue installation.

The Web Server dialog box appears.

Enter HTTPS port, server administrator e-mail address, and the SMTP server name.

The default HTTPS port number is 443. The SMTP server name is used by other CiscoWorks
applications. The HTTPS port and SMTP server name are mandatory.

From Common Services 3.0.5 onwards, the SMTP server name will be used for Common Services also.

Click Next to continue installation.

The Self-signed Certificate dialog box appears. The webserver uses the Self-signed certificate while
operating in secure mode.

Enter the country code, state, city, company, organization, and host name for HTTPS.
The host name is mandatory.

Click Next to continue installation.

The Create Desktop Shortcut dialog box appears.

If you want to create a shortcut to CiscoWorks on your desktop, select the check box.
If Integration Utility has not been selected as one of the options, go to Step 25.

Click Next to continue installation.

The Integration Utility dialog box appears.

Select either of the following:

¢ Integrate Later to integrate with a third-party NMS after installation. This completes the
installation quickly and avoids installation failure caused by errors in the third-party integration.

If you select Integrate Later, go to Step 25.
¢ Integrate Now to integrate with a third-party NMS during installation.

If you select Integrate Now, perform steps a through g.
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Step 25

Step 26

Click Next to continue.
The Integration Utility Adapters dialog box appears, displaying a list of adapters.
Select any of the following:

— The adapter from the list of available adapters,

— Other to choose an adapter that is not listed (you will be prompted to enter the path name of
the adapter),

— None to integrate after the installation is complete.
If you select None, go to Step 25.
Click Next to continue.

The Integration Utility-NMIDB Updates dialog box appears. Specify whether you want to enable
download updates to NMIDB (Network Management Integration Data Bundle) directly from
Cisco.com.

Select either of the following:
— No to disable future updates from Cisco.com.
— Yes to enable future updates from Cisco.com.
If you select No, go to Step 25.
Click Next to continue.
The Cisco.com login page appears.
Enter your Cisco.com user ID and password.

You must have Cisco.com login privileges. If you do not have a user account and password on
Cisco.com, contact your channel partner or enter a request on the standard Cisco.com web site
(www.cisco.com).

Click Next to continue.

The Summary dialog box appears with the summary of settings for the installation.

If you want to view passwords and other security sensitive data, click Show Details. The Show
Details button is visible only if Common Services has been installed as one of the options.

a. Click Show Details, to display the Security Alert dialog box.

b. Click Yes in the Security Alert dialog box to view the Summary page with the passwords and
other security sensitive data.

You can select and copy the data from the Summary page.
If you want to change any settings, click Back.

If you want to hide the details, click Hide Details.

Click Next to continue.

The installation proceeds.

If you are installing from a network drive, the installation might take longer to complete. This happens
especially for CiscoView device packages.

The Restart dialog box appears after installation completes.
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Step 27 Select Yes and click Finish.

A

Caution  You must reboot the system after installing Common Services 3.0.3 and then proceed to install Common
Services 3.0.5. The installation of other CiscoWorks products may fail if you do not restart..

Your Windows machine has CS 3.0.3 installed successfully.
Now, from the LMS 2.6 Update CD ROM you need to install CS 3.0.5.
To install CS 3.0.5 from LMS 2.6 Update CD:
Step28 Log in as the local administrator on the system on which you installed Common Services 3.0.3.
Step29 Insert the LMS 2.6 CD-ROM into a CD-ROM drive.
The Installer window appears.
If the Installer window does not appear:
a. Select Start > Run.
The Run dialog box opens.
b. In the Open field, enter drive:\autorun.exe
where drive is the CD-ROM drive letter.
Step30 While installing from the network drive, the Installing from Network Drive window appears.
Installation from network drive will be slower when compared to installing from the local drive.
Click Yes to proceed or No to exit installation.
Step31 If the WMI service is up and running, the following message appears when installation starts.

The setup program has detected Windows Management Instrumentation (WMI) services running.
This will lock some cisco works processes and may abort installation abruptly.

To avoid this, installation will stop and start the WMI services.

Do you want to proceed?

Click Yes to proceed with this installation.
Click No to exit installation.
Step32 The IIS detection window appears.
IIS should be in disabled state. If not, to disable IIS in your machine, follow the instructions as below:
e Select Start < Run < services.msc < IIS Admin Service.
e Right click on IIS Admin Service and click Stop.
e IIS is now disabled. You need to go back to your installation screen to resume installation.
Step33 Click OK to continue.
The Welcome window appears.
Step34 Click Next to continue.

The Software License Agreement window appears.

Installation and Setup Guide for CiscoWorks Common Services 3.0.5 (Includes CiscoView 6.1.5) on Windows
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Step35 Click Accept to accept the license agreement and proceed with the installation.

The Install Updates screen appears displaying the new updates that needs to be installed as well as the
updates that are already installed.

Note  The new updates list will display all applications you previously installed during CS 3.0.3 installation
that now require to be updated to the LMS 2.6 level. CiscoView 6.1.5 is also listed here.

Step36 Click either Next to proceed with the installation or Cancel to exit from the installation.
The System Requirements screen appears:

Step37 Click Next.
The Summary window appears.

Step38 Click Next.

The Setup screen appears, displaying installation progress while files are copied and applications are
configured.

If you have not installed all the LMS 2.5.1 applications before installng the LMS 2.6 Update, the
installation aborts with the following error message (for example, if Resource Manager Essentials 4.0.3
application was not installed):

Install Resource Manager Essentials 4.0.3 before updating to Resource Manager Essentials
4.0.5.

See the ReadMe and the Installation Guide for details.
The following message appears:

If you plan to install any of the LMS 2.5.1 applications, you must reinstall CiscoWorks
LMS 2.6 Update after installing these applications.

Step39 Click OK.
The Setup Complete dialog box appears.
Step40 Click Finish.
You have completed the CS 3.0.5 installation from the LMS 2.6 Update CD ROM.

Your Windows machine has CS 3.0.5 installed successfully.

See “Checking for Installation Errors for Common Services 3.0.5” section on page 2-34 for details on
installation errors.

]

To prepare the client system for use, see Chapter 3, “Preparing to Use CiscoWorks Common Services.

For troubleshooting information, see Appendix A, “Troubleshooting the Installation.”

Installation and Setup Guide for CiscoWorks Common Services 3.0.5 (Includes CiscoView 6.1.5) on Windows
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Performing Upgrade Installation

This section contains:
e (Critical Note on Upgrade and Re-installation
e Upgrade Installation Notes for CS 3.0.5
e Co-existence of CS 3.0.5 With Other CiscoWorks Applications During Upgrade
e CiscoWorks—ACS Task Registration During Upgrade and Re-installation
Common Services 3.0.5 supports upgrade from:
¢ CiscoWorks Common Services 3.0.4
¢ CiscoWorks Common Services 3.0.3
The data is preserved when you perform an upgrade.

For a description of the different upgrade paths and their results, see “Table 1-1Upgrade Paths” section
on page 1-2.

Critical Note on Upgrade and Re-installation

Step 1
Step 2
Step 3

During upgrade installation and re-installation, if some files are being used by other processes, the
installation program displays the Stop All Programs dialog box. This dialog box lists all the files that are
currently being used by other running processes.

You must stop all processes corresponding to the listed files before you proceed with the installation.

To detect the processes corresponding to the locked files, you can use Process Explorer available for
download from http://www.sysinternals.com.

To stop the processes corresponding to the locked files:

Download Process Explorer from http://www.sysinternals.com.

Using Process Explorer, detect the corresponding processes for the files listed.
Terminate the processes.

See the Process Explorer Online help for more details.

After the processes are stopped, you can click Next in the Stop All Programs dialog box and proceed
with the installation.

When you click Next and proceed with the installation, you may get a message box titled Verify Stopped
Processes with the following message:

Do you want to verify that Ciscoworks files are no longer being used by running processes.
Click Yes to verify that files are no longer in use and that the installation may proceed.

Click No to proceed without verification.

You must click Yes and proceed with the verification. The installation might end up abruptly, if you click
No.
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Upgrade Installation Notes for CS 3.0.5

Note the following before you start upgrading to Common Services 3.0.5:

You can upgrade to Common Services 3.0.5 by installing the new version on the system that is
currently running Common Services 3.0.3 or Common Services 3.0.4.

Upgrade installation preserves the settings from the product installed earlier.

We recommend that you save yo ur data to a backup file before you perform the local upgrade. If
your installation fails, you can retrieve this saved data.

Upgrade overrides the previous versions. The old version will not be available after you upgrade to
Common Services 3.0.5.

Note the following before you start upgrading to Common Services 3.0.3:

You can upgrade to Common Services 3.0.3 by installing the new version on the system that is
currently running a previous version.

Upgrade installation preserves the settings from the product installed earlier.

We recommend that you save your data to a backup file before you perform the local upgrade. If
your installation fails, you can retrieve this saved data.

Upgrade overrides the previous versions. The old version will not be available after you upgrade to
Common Services 3.0.3.

During upgrade installation:
— If you leave any field blank, CiscoWorks uses the values from the previous installation.

— If you have not entered a password for CiscoWorks admin, guest users, and System Identity
Account during the previous installation, you must enter a new password for the installation to
proceed.

- If you select the Custom option during the upgrade installation, all the dialog boxes display the
default values or the settings from the previous installation. You can accept these values or
modify them.

— The installation attempts to use existing passwords. If the installation does not generate random
passwords, you may provide the passwords manually.

— The installation does not use the randomly generated password if the password does not comply
with the policies set by the local administrator.

— You can preserve the Self-signed Certificate. To do this, select Keep Existing Certificate option
to configure the webserver to use the existing certificate.
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Co-existence of CS 3.0.5 With Other CiscoWorks Applications During Upgrade

The following notes give details on the co-existence of Common Services 3.0.5 with other CiscoWorks
applications:

Earlier versions of other CiscoWorks applications are not fully compatible with Common Services
3.0.5. The system might be unstable if you run the previous versions of applications along with
Common Services 3.0.5

— You must upgrade all LMS 2.5.1 applications to LMS 2.6, if you are upgrading from any of the

following:
CiscoWorks Common Services 3.0.4

CiscoWorks Common Services 3.0.3

The following notes give details on the co-existence of Common Services 3.0.3 with other CiscoWorks
applications:

Earlier versions of other CiscoWorks applications are not fully compatible with Common Services
3.0.3. The system might be unstable if you run the previous versions of applications along with
Common Services 3.0.3

— Ifyouare upgrading from CiscoWorks Common Services 2.2 or CDOne,5th Edition or Core 1.0,

the corresponding versions of other applications are disabled. After installation completes, data
from the earlier versions is carried over to the new version and the active state of the products
is restored.

You must upgrade all LMS 2.5 applications to LMS 2.5.1, if you are upgrading from any of the
following:

CiscoWorks Common Services 3.0 Service Pack 2
CiscoWorks Common Services 3.0 Service Pack 1
CiscoWorks Common Services 3.0

A warning message appears during the upgrade installation if you have the previous versions of
the applications.

For example, if you have installed RME 4.0.0, CM 4.0.0, and DFM 2.0.0, and you are upgrading
to Common Services 3.0.3, the following warning message appears:

This server has the following applications(s) installed:

RME 4.0.0 CM 4.0.0 DFM 2.0.0

The system might be unstable if you run the above versions of the application(s),
along with CS 3.0.3.

Ensure that you upgrade the application(s) to:

RME 4.0.3 CM 4.0.3 DFM 2.0.3

We recommend that you upgrade all the applications on your server to the corresponding LMS

2.5.1 versions.

If you have installed Device Fault Manager (DFM) on your system, and
HP OpenView Network Node Manager (HPOVNNM) or NetView is running on the same machine,
you must stop HPOVNNM/NetView and proceed with the upgrade.
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e Common Services 3.0.3 cannot co-exist with Qos Policy Manager (QPM). If you are upgrading from
CiscoWorks Common Services 2.2 and if QPM is detected, the following error message appears:

Qos Policy Manager (QPM) is detected on this server. Common Services 3.0.3 cannot
co-exist with QPM. We recommend that you either:

Install Common Services 3.0.3 on a separate server

Or

Restore the current setup with QPM on a separate server, uninstall QPM on this server,
and then install Common Services 3.0.3.

You must either install Common Services 3.0.3 on a separate server or uninstall QPM and proceed
with the upgrade on the same server.

CiscoWorks—ACS Task Registration During Upgrade and Re-installation

~

Note

Common Services supports integration with CiscoSecure Access Control Server (ACS).

ACS Task Registration During Upgrade and Re-installation is common for both Common Services 3.0.3
as well as Common Services 3.0.5.

ACS provides authentication, authorization, and accounting services to network devices that function as
AAA clients. ACS supports Common Services client applications by providing command authorization
for network users who use the management application to configure managed network devices.

You can register all installed applications with the ACS server either through Common Services >
Server > Security > AAA Mode Setup or through the acsrRegcli.pl command line script.

See User Guide for Ciscoworks Common Services 3.0.3 for more details on registering applications with
ACS.

When an application that has new tasks to be registered with ACS is installed, you have an option to
register that specific application with ACS during installation.

During the upgrade installation and re-installation of Common Services (with CiscoView), the
installation framework might prompt you to confirm the application registration with ACS. This occurs
if you have not already registered either Common Services or CiscoView or both with ACS.

This is applicable only when the server is already configured to be in ACS mode.In this scenario, the
following warning message appears:

The application that you are installing requires new tasks to be registered with ACS. If
yvou have already registered this application with ACS from another server, you do not
need to register it again. However if you re-register the application, you will lose any
custom roles that you had created earlier for this application in ACS.

Click Yes to register and continue installing.
Click No to not register and continue installing.

Click Cancel to stop installing.
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Click No and continue the installation if you have registered the applications with ACS already from
another server.

If you click Yes and continue the installation, the application will be registered with ACS. If the
application is already registered with ACS, from a different server, you will lose any custom roles that
you have created for the application in ACS.

Click Cancel to stop the installation

Even if you choose not to register the application with ACS during installation, you can do it later from
the GUI or CLI, as mentioned above.

Upgrade Installation for Common Services 3.0.5

Upgrade installation to CS 3.0.5 can be performed as follows:

If you have CS 3.0 Service Pack 2 or CS 3.0 Service Pack 1 or CS 3.0 already installed on your machine,
you must upgrade to CS 3.0.3 by following the steps below and then upgrade to CS 3.0.5.

You can install CS 3.0.5 using either the Typical or the Custom mode:

e Select Typical to select the components and install the selected components in the default location
(System Drive\Program Files\CSCOpx). This is the default installation mode.
(See the Upgrade Installation—Typical section.)

¢ Select Custom to select optional components, customize the settings, and to specify the location.
(See the Upgrade Installation—Custom section.)

Upgrade Installation—Typical

Step 1

Step 2

Step 3

Step 4

To upgrade install CS 3.0.5, you must first upgrade to CS 3.0.3 using the Typical mode, from the LMS
2.5.1 CD (install CS 3.0.3 from the CD One 3.0.3 CD ROM), and then proceed with installing CS 3.0.5
from the LMS 2.6 Update CD-ROM. To proceed with the installation:

Install the required software as described in the “Server Requirements” section on page 1-3.

If you are running Windows 2000, make sure Windows 2000 Service Pack 3 or Service Pack 4 is
installed. If you have Service Pack 1, and or Service Pack 2, the installation exits.

Insert the CS 3.0.3 CD-ROM into a CD-ROM drive.
The Installer screen appears.

Click Install to continue.

The Welcome screen appears.

Click Next to continue.

The Software License Agreement dialog box appears.
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Step 5

Step 6

Step 7

Step 8

Click Accept to accept the license agreement and proceed with the installation.
To deny the agreement and stop the installation, click Do Not Accept.

e If you select Accept, and continue with the installation, the installation program checks the name
lookup and Dynamic Host Configuration Protocol (DHCP).

e If static IP address is not configured on your system, the DHCP-Enabled Network Adapters dialog
box appears. Click Yes to continue installation.

The Setup Type dialog box appears.

Click Next to continue after you select the desired installation mode as Typical (see Installation Modes,
page 2-7).

If the installation program detects VPN monitor, or ACLM, or both, a dialog box appears asking whether
you want to continue upgrading on the same server, or install Common Services 3.0.3 on a separate
server.

If you continue with the upgrade, the system uninstalls the software as part of RME 4.0 upgrade.
The Backup Data dialog box appears.

Enter a backup directory and click Next.

Or

Click Browse to select a backup directory and click Next.

The installation program backs up the data.

If the backup fails, the Backup Data dialog box appears with the following message:

Backup operation failed. Please look at Backup directory\backup.log for the reason for
failure.

e Click Retry to try backup again.
Or
¢ Click Exit to exit the installation.

If the backup fails, check the backup log files and correct the backup errors specified in the backup log
files.

If you still have the errors, contact the Technical Assistance Center (TAC). TAC will guide you how to
continue upgrading without taking a backup.

If backup is completed, a dialog box appears with the following message. This message appears only if
you upgrade from CDOne 5th Edition/CWCS 2.2 to Common Services 3.0.3.

This is an upgrade to CiscoView 6.1.2. The CiscoView related date like Device List,
Preferences etc, will not be preserved during the upgrade. Do you want to continue?

Click Yes and continue with the installation.
If you click No, the installation exits.

If you have a different set of components in the previous version, the Select Components dialog box
appears.

Select the components you want to install and continue with the installation.
The installation program checks component requirements.

The System Requirements dialog box appears.
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The System Requirements dialog box displays the system requirements, available space in the drive and
Temp Directory (%TEMP%), and available memory in megabytes.

e If your system does not meet the requirements, a warning appears:

System memory is less than the minimum requirement, which may affect performance.
e [f the drive does not have enough space, an error message appears:

There is not enough space in drive drive name.

Please free some space on drive drive name.
e If your system does not have the minimum CPU speed, a warning appears:

Warning: Current CPU speed is less than the minimum requirement, which may affect
performance.

e If your system does not have the minimum swap space, a warning appears:

Warning: Current swap space is less than the minimum requirement, which may affect
performance.

Click Next to continue.
The Change System Identity Account Password dialog box appears.
Enter the System Identity Account password and confirm it.

This step is applicable only if you are upgrading from CiscoWorks Common Services 2.2 or
CD One, 5th Edition or CORE1.0.

In a multi-server environment, you must configure all systems part of your multi-server setup with the
same system identity account password.

For more information on passwords, see “Password Information”appendix.
Click Next to continue.
The Summary dialog box appears with the summary of settings for the installation.

e If you want to view passwords and other security sensitive data, click Show Details. The Show
Details button is visible only if Common Services has been installed as one of the options.

a. Click Show Details, to display the Security Alert dialog box.

b. Click Yes in the Security Alert dialog box to view the Summary page with the passwords and
other security sensitive data.

You can select and copy the data from the Summary page.
e If you want to change any settings, click Back.
¢ Click Hide Details to hide the details.
Click Next to continue.
The installation proceeds.

If you are installing from a network drive, the installation might take longer to complete. This happens
especially for CiscoView device packages.

The Restart dialog box appears after installation completes.
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Step 13

A

Select Yes, and click Finish.

Caution

Step 14
Step 15

Step 16

Step 17

Step 18

Step 19

Step 20

You must reboot the system after upgrade installation of Common Services 3.0.3 and then install
Common Services 3.0.5. The installation of other CiscoWorks products may fail if you do not restart.

Your Windows machine has ugraded to CS 3.0.3 successfully.
Now, from the LMS 2.6 Update CD ROM you need to upgrade to CS 3.0.5.
To install CS 3.0.5 from LMS 2.6 Update CD:
Log in as the local administrator on the system on which you installed Common Services 3.0.3.
Insert the LMS 2.6 CD-ROM into a CD-ROM drive.
The Installer window appears.
If the Installer window does not appear:
a. Select Start > Run.
The Run dialog box opens.
b. In the Open field, enter drive:\autorun.exe
where drive is the CD-ROM drive letter.
While installing from the network drive, the Installing from Network Drive window appears.
Installation from network drive will be slower when compared to installing from the local drive.
Click Yes to proceed or No to exit installation.

If the WMI service is up and running, the following message appears when installation starts.

The setup program has detected Windows Management Instrumentation (WMI) services running.

This will lock some cisco works processes and may abort installation abruptly.
To avoid this, installation will stop and start the WMI services.

Do you want to proceed?

Click Yes to proceed with this installation.

Click No to exit installation.

The IIS detection window appears.

IIS should be in disabled state. If not, to disable IIS in your machine, follow the instructions as below:

e Select Start < Run < services.msc < IIS Admin Service.

e Right click on IIS Admin Service and click Stop.

e IIS is now disabled. You need to go back to your installation screen to resume installation.
Click OK to continue.
The Welcome window appears.
Click Next to continue.

The Software License Agreement window appears.
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Step21 Click Accept to accept the license agreement and proceed with the installation.

The Install Updates screen appears displaying the new updates that needs to be installed as well as the
updates that are already installed.

Note  The new updates list will display all applications you previously installed during CS 3.0.3 installation
that now requires an update to the LMS 2.6 level. CiscoView 6.1.5 is also automatically listed here.

Step22 Click either Next to proceed with the installation or Cancel to exit from the installation.
The System Requirements screen appears:

Step23 Click Next.
The Summary window appears.

Step24 Click Next.

The Setup screen appears, displaying installation progress while files are copied and applications are
configured.

If you have not installed all the LMS 2.5.1 applications before installng the LMS 2.6 Update, the
installation aborts with the following error message (for example, if Resource Manager Essentials 4.0.3
application was not installed):

Install Resource Manager Essentials 4.0.3 before updating to Resource Manager Essentials
4.0.5.

See the ReadMe and the Installation Guide for details.
The following message appears:

If you plan to install any of the LMS 2.5.1 applications, you must reinstall CiscoWorks
LMS 2.6 Update after installing these applications.

Step25 Click OK.
The Setup Complete dialog box appears.
Step26 Click Finish.

You have completed the CS 3.0.5 installation from the LMS 2.6 Update CD ROM and your Windows
machine has CS 3.0.5 installed successfully.

See “Checking for Installation Errors for Common Services 3.0.5” section on page 2-34 for details on
installation errors.

s

To prepare the client system for use, see Chapter 3, “Preparing to Use CiscoWorks Common Services.’

For troubleshooting information, see Appendix A, “Troubleshooting the Installation.”
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Upgrade Installation—Custom

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6
Step 7

Step 8

The Custom option preserves the settings from the product installed earlier. Dialog boxes appear with
the settings from the previous installation. You can accept these values or modify them.

To upgrade install CS, you must first upgrade to CS 3.0.3 using the Custom mode, from the LMS 2.5.1
CD (install CS 3.0.3 from the CD One 3.0.3 CD ROM), and then proceed with installing CS 3.0.5 from
the LMS 2.6 Update CD-ROM. To do this:

Install the required software as described in the “Server Requirements” section on page 1-3.

If you are running Windows 2000, make sure Windows 2000 Service Pack 3 or Service Pack 4 is
installed. If you have Service Pack 1, and or Service Pack 2, the installation exits.

Insert the CS 3.0.3 CD-ROM into a CD-ROM drive.

The Installer screen appears.

Click Install to continue.

The Welcome screen appears.

Click Next to continue.

The Software License Agreement dialog box appears.

Click Accept to accept the license agreement and proceed with the installation.
To deny the agreement and stop the installation, click Do Not Accept.

e If you select Accept, and continue with the installation, the installation program checks the name
lookup and Dynamic Host Configuration Protocol (DHCP).

e If static IP address is not configured on your system, the DHCP-Enabled Network Adapters dialog
box appears. Click Yes to continue installation.

The Setup Type dialog box appears.

Click Next to continue after you select the upgrade installation mode as Custom (see Installation Modes,
page 2-7).

If the installation program detects VPN monitor, or ACLM, or both, a dialog box appears asking whether
you want to continue upgrading on the same server, or install Common Services 3.0.3 on a separate
server.

If you continue with the upgrade, the system uninstalls the software as part of RME 4.0 upgrade.
The Backup Data dialog box appears.

Enter a backup folder and click Next.

Or

Click Browse to select a backup folder and click Next.

The installation program backs up the data.
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If backup fails, the Backup Data dialog box appears with the following message:

Backup operation failed. Please look at Backup directory\backup.log for the reason for
failure.

e Click Retry to try backup again.
Or
e Click Exit to exit the installation.

If the backup fails, check the backup log files and correct the backup errors specified in the backup log
files.

If you still have the errors, contact the Technical Assistance Center (TAC). TAC will guide you how to
continue upgrading without taking a backup.

If backup is completed, a dialog box appears with the following message. This message appears only if
you upgrade from CDOne 5th Edition/CWCS 2.2 to CS 3.0.3.

This is an upgrade to CiscoView 6.1.2. The CiscoView related date like Device List,
Preferences etc, will not be preserved during the upgrade. Do you want to continue?

Click Yes and continue with the installation.
If you click No, the installation exits.

If you have a different set of components in the previous version, the Select Components dialog box
appears. The number of components in the dialog box will vary based on the previous installation.

Select the components you want to install and continue with the installation.
The installation program checks component requirements.
The System Requirements dialog box appears.

e The System Requirements dialog displays the system requirements, available space in the drive and
Temp Directory (%TEMP%), and available memory in megabytes.If your system does not meet the
requirements a warning appears:

System memory is less than the minimum requirement, which may affect performance.
e [f the drive does not have enough space, an error message appears:

There is not enough space in drive drive name.

Please free some space on drive drive name
e If your system does not have the minimum CPU speed, a warning appears:

Warning: Current CPU speed is less than the minimum requirement, which may affect
performance.

e If your system does not have the minimum swap space, a warning appears:

Warning: Current swap space is less than the minimum requirement, which may affect
performance.

Click Next to continue.
The Change Admin and Guest Password dialog box appears.
Enter CiscoWorks admin and guest passwords and confirm them.

You may change the passwords for the admin and guest users. To keep the existing passwords, leave the
fields blank and click Next to continue installation.

For more information on passwords, see Appendix B, “Password Information.”
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Step 12

Step 13

Step 14

Step 15

Step 16

Step 17

Step 18

Step 19

Step 20

Step 21

Step 22

Click Next to continue installation.
The Change System Identity Account Password dialog box appears.
Enter the System Identity Account password and confirm it.

If you are upgrading from CiscoWorks Common Services 3.0 Service Pack 2 or CiscoWorks Common
Services 3.0 Service Pack 1 or CiscoWorks Common Services 3.0, a dialog box appears where you can
change the System Identity account password, or leave the fields blank to retain the existing password.

In a multi-server environment, you must configure all systems part of your multi-server setup with the
same system identity account password.

For more information on passwords, see Appendix B, “Password Information.”
Click Next to continue.
The Change casuser Password dialog box appears.

Casuser is the user who administers and maintains CiscoWorks Server without having administrative
privileges.

Enter the causer password and confirm it.

This password must conform to the system administrator policies. The installation program adds the user
casuser and the group casusers to the system. If you do not enter a password, the setup program will
generate a random password.

For more information on passwords, see Appendix B, “Password Information.”
Click Next to continue installation.

The Common Services Database Password dialog box appears.

Enter the password, and confirm it.

Leave the fields blank to use the existing password.

For more information on passwords, see Appendix B, “Password Information.”
Click Next to continue installation.

The Web Server Configuration dialog box appears.

Enter HTTPS port, server administrator e-mail address, and the SMTP server name.

The default HTTPS port number is 443. The SMTP server name is used by other CiscoWorks
applications. The HTTPS port and SMTP server name are mandatory.

Click Next to continue installation.

The Self-signed Certificate dialog box appears. The webserver uses the Self-signed certificate while
operating in secure mode. By default, the installation program uses the existing Self- signed Certificate
information.

If you want to generate a new certificate, uncheck the Keep existing certificate check box, and enter the
country code, state, city, company, organization, and host name for HTTPS. The host name is mandatory.
You can leave the other fields blank.

Click Next to continue installation.

The Create Desktop Shortcut dialog box appears.

If you want to create a shortcut to CiscoWorks on your desktop, select the check box.
If Integration Utility has not been selected as one of the options, go to Step 24.

Click Next to continue installation.

The Integration Utility dialog box appears.
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Step23 Select one of the following:
¢ Integrate Later to integrate with a third-party NMS after installation. This completes the
installation more quickly and avoids installation failure caused by errors in the third-party
integration.
If you select Later, go to Step 24.
¢ Integrate Now to integrate with a third-party NMS during installation.
If you select Integrate Now, continue with steps a through g.
a. Click Next to continue.
The Integration Utility Adapters dialog box appears, displaying a list of adapters.
b. Select any of the following:
— The adapter from the list of available adapters,
— Other to choose an adapter that is not listed (you are prompted to enter the path name of the
adapter),
— None to integrate after the installation is complete.
If you select None, go to Step 24.
c. Click Next to continue.
The Integration Utility NMIDB Updates dialog box appears.
d. Specify whether you want to enable download updates to NMIDB (Network Management
Integration Data Bundle) directly from Cisco.com.
e. Select either of the following:
— No to disable future updates from Cisco.com.
— Yes to enable future updates from Cisco.com.
If you select No, go to Step 24
f. Click Next to continue.
The Cisco.com login page appears.
g. Enter your Cisco.com user ID and password.
You must have Cisco.com login privileges. If you do not have a user account and password on
Cisco.com, contact your channel partner or enter a request on the standard Cisco.com web site.
Step24 Click Next to continue.
The Summary dialog box appears, displaying the summary of settings for the installation.
To view passwords and security sensitive data, click Show Details.
The Show Details button is visible only if Common Services has been installed as one of the options.
The installation program displays only the new and changed passwords. You can select and copy the data
from the Summary dialog box.
Step25 Click Next to continue.
The installation proceeds.
If you are installing from a network drive, the installation might take longer to complete. This happens
especially CiscoView device packages.
The Restart dialog box appears after installation completes.
Installation and Setup Guide for CiscoWorks Common Services 3.0.5 (Includes CiscoView 6.1.5) on Windows
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Step26 Select Yes and click Finish.

A

Caution  You must reboot the system after upgrade installation of Common Services 3.0.3 and then install
Common Services 3.0.5. The installation of other CiscoWorks products may fail if you do not restart.

Your Windows machine has ugraded to CS 3.0.3 successfully.
Now, from the LMS 2.6 Update CD ROM you need to upgrade to CS 3.0.5.
To install CS 3.0.5 from LMS 2.6 Update CD:
Step27 Log in as the local administrator on the system on which you installed Common Services 3.0.3.
Step28 Insert the LMS 2.6 CD-ROM into a CD-ROM drive.
The Installer window appears.
If the Installer window does not appear:
a. Select Start > Run.
The Run dialog box opens.
b. In the Open field, enter drive:\autorun.exe
where drive is the CD-ROM drive letter.
Step29 While installing from the network drive, the Installing from Network Drive window appears.
Installation from network drive will be slower when compared to installing from the local drive.
Click Yes to proceed or No to exit installation.
Step30 If the WMI service is up and running, the following message appears when installation starts.

The setup program has detected Windows Management Instrumentation (WMI) services running.
This will lock some cisco works processes and may abort installation abruptly.

To avoid this, installation will stop and start the WMI services.

Do you want to proceed?

Click Yes to proceed with this installation.
Click No to exit installation.
Step31 The IIS detection window appears.
IIS should be in disabled state. If not, to disable IIS in your machine, follow the instructions as below:
e Select Start < Run < services.msc < IIS Admin Service.
e Right click on IIS Admin Service and click Stop.
e IIS is now disabled. You need to go back to your installation screen to resume installation.
Step32 Click OK to continue.
The Welcome window appears.
Step 33 Click Next to continue.

The Software License Agreement window appears.

Installation and Setup Guide for CiscoWorks Common Services 3.0.5 (Includes CiscoView 6.1.5) on Windows
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Step34 Click Accept to accept the license agreement and proceed with the installation.

The Install Updates screen appears displaying the new updates that needs to be installed as well as the
updates that are already installed.

Note  The new updates list will display all applications you previously installed during CS 3.0.3 installation
that now requires an update to the LMS 2.6 level. CiscoView 6.1.5 is also automatically listed here.

Step35 Click either Next to proceed with the installation or Cancel to exit from the installation.
The System Requirements screen appears:

Step36 Click Next.
The Summary window appears.

Step37 Click Next.

The Setup screen appears, displaying installation progress while files are copied and applications are
configured.

If you have not installed all the LMS 2.5.1 applications before installng the LMS 2.6 Update, the
installation aborts with the following error message (for example, if Resource Manager Essentials 4.0.3
application was not installed):

Install Resource Manager Essentials 4.0.3 before updating to Resource Manager Essentials
4.0.5.

See the ReadMe and the Installation Guide for details.
The following message appears:

If you plan to install any of the LMS 2.5.1 applications, you must reinstall CiscoWorks
LMS 2.6 Update after installing these applications.

Step38 Click OK.
The Setup Complete dialog box appears.
Step39 Click Finish.

You have completed the CS 3.0.5 installation from the LMS 2.6 Update CD ROM and your Windows
machine has been upgraded to CS 3.0.5 successfully.

See “Checking for Installation Errors for Common Services 3.0.5” section on page 2-34 for details on
installation errors.

s

To prepare the client system for use, see Chapter 3, “Preparing to Use CiscoWorks Common Services.’

For troubleshooting information, see Appendix A, “Troubleshooting the Installation.”

Installation and Setup Guide for CiscoWorks Common Services 3.0.5 (Includes CiscoView 6.1.5) on Windows
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Reinstalling Common Services 3.0.5

Step 1
Step 2

Step 3

Step 4

Step 5

Step 6

You can re-install Common Services 3.0.5 by running the installation program on the system currently
running the product.

Re-installation preserves the settings from the previous installation.

Common Services 3.0.5 will automatically be installed in the same location, where the previous version
was installed.

We recommend that you save your data to a backup file before you start reinstallation. If your installation
fails, you can retrieve this saved data. To do a back up, see “Upgrade Installation for Common Services
3.0.5” section on page 2-21.

For information about application registration if the server is in ACS mode, see “CiscoWorks—ACS Task
Registration During Upgrade and Re-installation” section on page 2-20.

See the “Critical Note on Upgrade and Re-installation” section on page 2-17 before proceeding the
re-installation.

To reinstall CS 3.0.5 from LMS 2.6 Update CD:

Log in as the local administrator on the system on which you installed Common Services 3.0.3.
Insert the LMS 2.6 CD-ROM into a CD-ROM drive.
The Installer window appears.
If the Installer window does not appear:
a. Select Start > Run.

The Run dialog box opens.
b. In the Open field, enter drive:\autorun.exe

where drive is the CD-ROM drive letter.
While installing from the network drive, the Installing from Network Drive window appears.
Installation from network drive will be slower when compared to installing from the local drive.
Click Yes to proceed or No to exit installation.

If the WMI service is up and running, the following message appears when installation starts.

The setup program has detected Windows Management Instrumentation (WMI) services running.
This will lock some cisco works processes and may abort installation abruptly.
To avoid this, installation will stop and start the WMI services.

Do you want to proceed?

Click Yes to proceed with this installation.

Click No to exit installation.

The IIS detection window appears.

IIS should be in disabled state. If not, to disable IIS in your machine, follow the instructions as below:
¢ Select Start < Run < services.msc < IIS Admin Service.
¢ Right click on IIS Admin Service and click Stop.
e IS is now disabled. You need to go back to your installation screen to resume installation.

Click OK to continue.
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Step 7

Step 8

Step 9

Step 10

Step 11

Step 12

Step 13

Reinstalling Common Services 3.0.5

The Welcome window appears.

Click Next to continue.

The Software License Agreement window appears.

Click Accept to accept the license agreement and proceed with the installation.

The Install Updates screen appears displaying the new updates that needs to be installed as well as the
updates that are already installed.

The new updates list will display all applications you previously installed during CS 3.0.3 installation
that now require to be updated to the LMS 2.6 level. CiscoView 6.1.5 is also listed here.

Click either Next to proceed with the installation or Cancel to exit from the installation.
The System Requirements screen appears:

Click Next.

The Summary window appears.

Click Next.

The Setup screen appears, displaying installation progress while files are copied and applications are
configured.

If you have not installed all the LMS 2.5.1 applications before installng the LMS 2.6 Update, the
installation aborts with the following error message (for example, if Resource Manager Essentials 4.0.3
application was not installed):

Install Resource Manager Essentials 4.0.3 before updating to Resource Manager Essentials
4.0.5.

See the ReadMe and the Installation Guide for details.
The following message appears:

If you plan to install any of the LMS 2.5.1 applications, you must reinstall CiscoWorks
LMS 2.6 Update after installing these applications.

Click OK.
The Setup Complete dialog box appears.
Click Finish.

You have completed the CS 3.0.5 installation from the LMS 2.6 Update CD ROM and your Windows
machine has reinstalled CS 3.0.5 successfully.

See “Checking for Installation Errors for Common Services 3.0.5” section on page 2-34 for details on
installation errors.

To prepare the client system for use, see Chapter 3, “Preparing to Use CiscoWorks Common Services.”

For troubleshooting information, see Appendix A, “Troubleshooting the Installation.”
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Checking for Installation Errors for Common Services 3.0.5

If errors occur during installation, you can look at the installation log to determine the error. This log is
located in the root directory on the drive where the operating system is installed.

The default is C:\Ciscoworks_install_YYYYMMDD_hhmmss.log, where YYYYMMDD denotes the

current year, month and date.

Each installation creates a log that is saved as a different file. Check the most recent log file for error
messages.

Verifying CS 3.0.5 Installation

You can verify product installation by entering the command pdshow from your command prompt. The

following processes must appear:

Apache
CMFOGSServer
CSRegistryServer
CmfDbEngine
CmfDbMonitor
DCRServer

EDS

EDS-GCF
EDS-TR

ESS

EssMonitor
LicenseServer
Proxy
RmeGatekeeper
RmeOrb

Tomcat
TomcatMonitor
diskWatcher

jrm
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Uninstalling CiscoWorks Common Services 3.0.5

A

This section contains:
e Uninstalling Common Services
e Notes on Uninstallation

Use the Uninstall option to remove CiscoWorks Common Services files and settings. You must be logged
in as administrator to remove Common Services.

You cannot uninstall Common Services when other applications that are dependent on Common Services
are installed. Before uninstalling Common Services, uninstall these application.

For example, if you select Common Services without selecting CiscoView, the following message
appears:

Cannot uninstall CiscoWorks Common Services.

It is required for CiscoView.

Uninstall all applications dependent on Common Services before uninstalling Common Services.

Caution

You must use the Uninstall script to remove the product. If you try to remove CiscoWorks Common
Services or its components manually, you may damage your system.

Uninstalling Common Services

Step 1
Step 2

Step 3

To uninstall Common Services:

Go to the Windows desktop, select Start > Programs > CiscoWorks > Uninstall CiscoWorks.
If the WMI service is up and running, the following message appears when uninstallation starts.

The setup program has detected Windows Management Instrumentation (WMI) services running.
This will lock some cisco works processes and may abort uninstallation abruptly.
To avoid this, uninstallation will stop and start the WMI services.

Do you want to proceed?

Click Yes to proceed with this uninstallation.

Click No to exit uninstallation.

The Uninstallation dialog box appears with the installed components.
Select the components you want to remove and click Next.

Or

Click Select All to uninstall all the components and click Next.

The Uninstallation dialog box lists the selected components.
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Step4  Click either:
e Next to continue uninstallation.
Or
e Back to return to the component selection box.
If you have selected Uninstall All, you cannot return to the component selection box using Back button.

The uninstallation proceeds and the Uninstallation Complete dialog box appears after uninstallation
completes.

Step5  Select Yes, I want to restart my computer now and click Finish.

A

Caution  If you select to uninstall Common Services, you must restart your system after the uninstallation is
complete. The subsequent installation of other CiscoWorks products may fail if you do not restart your
system.

Notes on Uninstallation

Following are some precautionary notes on uninstallation:

e The uninstall log file will be generated using time stamp with the YYYYMMDD_hhmmss format,
for example, C:/CiscoWorks_uninstall_YYYYMMDD_hhmmss.

¢ You cannot uninstall Common Services 3.0.5 if any of your CiscoWorks applications depends on
Common Services 3.0.5.

¢ The install folder will be removed (with some caveats) and the casuser will be removed after
uninstallation of Common Services 3.0.5.
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